Overview


WaveFilter is a very powerful tool to help you improve your image. It expands your ability to produce professional results in less time. Think of WaveFilter as a virtual lens filter for your LightWave 3D virtual camera. It applies the adjustments to your Lightwave 3D renderings on a pixel-by-pixel bases for maximum quality. Use WaveFilter to create completely new looks, or simply use it to improve the quality of your favorite renderings. Either way, you’ll save time...and time is money!


Automatic Installation


Run A:Setup. 


1) 	Insert the WAVEFILTER diskette into your computers A: drive.


2) 	Choose “File/Run” from the Program Manager or “Start/Run” in Win95. 	


3) 	Enter “A:Setup” and click OK. 


4) 	Follow the screen instructions.


	(Ignore any SHARE related errors that may occur durring installation - Just click OK)


Manual Installation (if automatic installation fails)


1) 	Copy the plug-in files (“*.p”) from the WAVEFILTER diskette 


	to your “NewTek\Plugins\Layout” folder. 


2) 	Run Lightwave Layout and select the “Options” menu.


	Click on “Add Plug-ins”. 


3)	Select “WavFltr1.p” from the “NewTek\Plugins\Layout” 


	directory where you copied it. 


4)	Also add WavFltr2.p, WavFltr3.p and WavFltr4.p to 


	complete your install.


Accessing the WAVEFILTER Controls


1)	Load Lightwave 3D version 4.0  


2)	Click on “Effects” to open the Effects Panel  


3)	Click on the “Image Filter Plug-ins” button.


4)	Click and hold the top Pop-up Menu button and 


	move the to select “WAVEFILTER Plug-in1”.


5)	Click the Options button to the right of WAVEFILTER Plug-in 1.





Tip:	This is where you make changes to WAVEFILTER.





•	Click OK to exit the WAVEFILTER Options dialog box to 


	record any changes you have made. 


•	Click Cancel to discard any changes you have made 


	and return to the Image Filter Plug-ins requester. The 


	filter settings you choose will be applied at the end of 


	each rendered frame. 


•	Click “Continue” to return to the effects panel.


8 Steps to an Excited LightWave 3D Artist


1)	Load Layout.


2)	Load your favorite scene.


3)	Render at MedRes and Medium Antialias with a 


	threshold of 8. Write down the time.


4)	Follow steps 1 through 4 on the opposite page 


	(Select WAVEFILTER and display dialog box)


5)	Click the Antialias check box and click OK.


6)	Set LightWave to render at MedRes and Low Antialiasing with a threshold of 12.


7)	Compare the images and the render times.


8)	Smile, you made a great purchase! 


Color Filters


Within color filters, lower settings mean less of the filter you are adjusting and higher numbers mean more of whatever you are adjusting. A setting of %100 means no effect. 


Red, Green and Blue


Adjust the percentages of red, green and blue separately. A good use for this filter is to color correct composited scenes.


Bright


Controls the overall brightness of your image. Don’t reset the lights, or raise the ambient light level, use Bright! Midtones and highlights are most affected, while very dark shadows are not affected.


Gamma


Similar to bright, gamma effects only the midtones in your image. Combining Bright and Gamma produces a nice effect.


Contrast


Effects the contrast of your image. Midtones move towards or away from highlights and shadows.


Filters Should Affect


WAVEFILTER does not need to affect every pixel in your image. Many interesting effects require that a filter be applied to only the objects, background, shadows or only to a specific color range. 


Select “Full Frame” to tell WAVEFILTER to apply the selected effects to your entire image. 


Selecting “Objects Only” instructs WAVEFILTER to only affect the objects in your scene. Background images will be ignored, but an image mapped polygon background will be included.


Selecting “Background Only” instructs WAVEFILTER to only effect the background of your rendered image. 


Selecting “Shadows Only” instructs WAVEFILTER to only effect the areas that LightWave determines are shadows. 


Select “Hi/Low Color Range” to only effect the portions of your image that fall between the two selected colors. The affected colors include all colors with RGB values which fall between the two selected colors in all three color channels (RGB).


Often, when multiple WAVEFILTER passes are used, each pass will select a different portion of the image to effect. See the examples at the end of this manual for more information.


The filters settings you select will be applied at the end of each rendered frame and will include only the selected portions of your image.


Digital Filters


Blur


Blur simulates out-of-focus effect to be applied equally across your image. Blur is most commonly used on the background to help contrast your sharply focused objects in the foreground.


% represents how blurry your image will be.


Depth of Field Blur (DOF)


Depth Of Field Blur provides control over range of blur. 


% represents how much blur will be applied per meter from the focal point. F represents the focal point in meters.


Mastering Blur


Used properly, both blur and DOF blur help to add more depth to your image. DOF blur works by adding blur based on distance from the focal point(F). Objects at the same distance from the camera as F will be in sharp focus. Blur does not affect the Alpha channel.If you want an object 1 meter from the focal point to be  %100 blurred, then set % to 100. 


If you want an object at 10 meters to be %50 blurred, then set % to 5. Five percent per meter for ten meters is fifty percent.


Blur is becomes wider than it is tall after 40%.  Multiple passes at lower settings sometimes looks beter than a single pass at a higher setting.


A way to cheat an envelope for F is to attach all objects in your scene to a null and scale the null to change the real distance between objects.  See the DOFChess.lws example.


Enhance


Enhance is an edge seeking (low-pass) detail enhancing filter that will increase the sharpness between surface colors. It does this by exaggerating the difference in color between the two edges. This will often give the illusion that details have been enhanced. 


% represents the amount of enhancement that will be applied to the edges between surfaces. A setting of 100 will result in normal enhancement and a setting of 200 will double how sharp edges appear. A setting of 50 will only enhance edges a small amount.


Antialias


The Antialias Digital Filter is an edge softening tool that will smooth the edges between sharply contrasting surfaces. This helps to tone down the stair-step edges found in computer graphics.


% represents how smooth the selected edges should become.T represents how much of the image will be antialiased.


TIP: 	Try MedRes, Low Antialias with a Threshold of  32 plus WAVEFILTER antialias at %100, T100. Fast and fine!


Mastering Antialiasing


The antialiasing used by LightWave 3D is one of the finest that can be found anywhere. By rerendering selected portions of the image (oversampling) Lightwave 3D can produce very high quality images.


The cost for such perfection is longer rendering times. Each level of antialias costs a little more in time. Low is fast, but the quality is not quite good enough. Medium is what we are told most people use but the render times can hurt if you are tight on time. High is great and not much can improve on it. If only it didn’t take so long! 


WAVEFILTER helps you get the most out of each level of LightWave 3D antialias. WAVEFILTER is super fast, because it uses a method called biased weighted average pixel interpolation. It uses the result from all rendering passes and estimates the result of more rendering passes. It then applies this new information to your image simulating more rendering passes 


At %100, T100 WAVEFILTER tries to simulate high antialiasing when added to medium antialiasing. It simulates mediumantialiasing when added to low. While it helps to use WAVEFILTER	antialias even without LightWave 3D antialiasing, much better results will be found when the two are used together. 


TIP:	Use a setting of zero percent for the WAVFILTER antialias and it will paint white everywhere the T setting selects. This can help you optimize your T setting.


Noise


Add random luminance noise to your image. 


% represents how much noise will be present.


Posterize


This filter limits the colors in your image to smaller, evenly distrubuted, color palettes.


% represents how posterized your image should look.


NTSC Limit


This filter limits the colors in your image to levels which are NTSC compliant. Only highlights are affected.


Black and White


This filter converts your image to 256 shades of grey.


Negative


Converts your image to a negative representation.


Flip Frame


This filter flips your image (H) horizontal or (V) vertical.


Key Filters


Creates matte and clip map files. These files can be used by LightWave 3D or other programs for high quality compositing.


100% Black


Selected portions of your image will be painted black (RGB 0,0,0).


100% White


Selected portions of your image will be painted white (RGB 255,255,255).


TIP:	Make sure you select either objects only or background only or your entire image will be effected.


Luminance Key Prep


The luminance key prep digital filter limits the colors in your image to levels which allow perfect luminance keying.  


Select (B) black to assure that your image contains no RGB values below 21,21,21.


Select (W) white to assure that your image contains no RGB values above 234,234,234.


This gives you the ability to key these graphics over video without any leakage.


TIP:	Be sure to set the filter to only effect objects or your background will also be effected.


Negative Alpha


The negative alpha key filter reverses the values of the alpha channel. Normally the alpha channel contains white where objects exits and black where they do not. This filter reverses this.


Range Alpha


The range alpha key filter is used to create clipmap files from green screen images. The areas in your image which fall between the colors selected in the color range are painted black (RGB 0,0,0). All other portions of your image are painted white (RGB 255,255,255). Range Alpha affects both RGB and Alpha images.


A Dozen Steps to Green Screen Success


1)	Digitize clean, useable, green screen footage.


2)	Use a paint program to find the correct color range to mask.


3) 	Load the green screen footage it as an image sequence.


4) 	Select Range Alpha from WAVEFILTER dialog.


5) 	Select Range and choose colors for clipping.


6) 	Select record 24bit alpha and enter a name.


7) 	Render the scene to make clipmaps.


8) 	Load green screen image sequence.


9) 	Load new clipmap image sequence.


10) 	Load correctly sized polygon. Same aspect ratio as original green screen images.


11) 	Set object clipmap to clipmap image sequence.  (Z axis, auto size)


12) 	Set object surface to 100 luminosity, 0% diffuse and color texture map to green screen image. (Z axis, auto size)


TIP:	Check that both image and clip maps are set on Z axis and select auto size for both.


Finding Green Screen Values


Load several sample green screen frames into your favorite paint program. Use the eye dropper tool to sample the RGB values in the green screen portions of the images.


You need to find the lowest and highest possible values for each color channel (RGB). Always use all of the lowest values for the first color.


Green Screen Tips


1)	Keep the color of your green screen as even and unvaried as possible.


2)	Avoid radiosity from the green screen affecting the subject.


3)	No transparant objects. ie. smoke, water, glass


4)	No antialias or pixel blend on clipmap or image map.


Picking Range Colors


When you select “Range” under “Filters Should Effect” a color picker dialog box will be displayed. Use the RGB values on the lower right to enter the lowest RGB values to include in the range. Then click OK.


At that point, a second color picker dialog box will appear. Enter the highest allowed RGB values to select the second range color.


Don’t worry if the color selected does not look right. Remember, it is not the color but instead the RGB values that matter. Always build the 1st color with the lowest RGB values and 2nd with the highest.


Batch Processing


1) Load an image sequence.


2) Select the sequence to be the background image.


3) Set the WAVEFILTER and LightWave 3D adjustments


4) Set to record the needed file type and render.


TIP:	WaveFilter Antialias can be applied to most any image sequence for a cleaner image.  Use it to clean up an old renders that you still have in digital form. (Backups, digital recording...)  Great to beef up your demo reel.


Multiple WAVEFILTER Passes


There are four separate WAVEFILTER plugins, numbered 1 to 4, one for each possible image filter plug-in slot. Each pass can have different settings. 


You might use the 1st pass to antialias the full frame and the 2nd pass might blur just the background.


Use Lum. Key Prep (B), objects only, on the 1st pass and 100% Black key filter, background only, on the 2nd pass for a nice keyable frame.


Load WAVEFILTER Settings


Click on the File menu item on the WAVEFILTER dialog box. Choose Open and then select the WAVEFILTER settings file (.WFP) that represents the settings you wish to use.


Save WAVEFILTER Settings


Click on the File menu item on the WAVEFILTER dialog box. Choose Save As and then enter a filename to use to save the current settings.


Other Effects


Are there effects that you just can’t achieve or that take so many steps and are so time consuming that they you usually pass on doing them. Give Unlimited Potential a call, we would be glad to create custom effects for you.


WaveFilter Net+


Add ScreamerNet support, a softer blur, chroma noise and envelope control for most features by upgrading to WaveFilter Net+ today.  Call 913-685-2700 to order direct.


License Agreement


Unlimited Potential, Inc. grants licensee the limited right to install WaveFilter on one computer system for the sole purpose of use within LightWave 3D by NewTek, Inc. as an image filter plug-in. 


Licenses are required for each artist executing WaveFilter within any 24 hour period. 


Unlimited Potential, Inc. assumes no liability as to the suitability of this product to meet the needs of the user. The user is responsible for determining the usefulness and applicability of WaveFilter to any project.


Unlimited Potential, Inc. assumes no liability beyond product replacement for a defective diskette within 90 days of purchase. Items deemed defective by Unlimited Potential, Inc. may be repaired or replaced at Unlimited Potential, Inc. choice with the shipping cost paid by the user. 


Backup copies of the program can not be made. Only the original disk licensed to the user may be used to install WaveFilter on a single computer system. User must send in the registration card enclosed in the WaveFilter package, via U.S. Mail, before installing WaveFilter on any computer system.
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